SPiRil

SOFIWARE SOILULIiONS

Getting Started with TSM Studio

This document is a “work in progress” and is currently being released in draft form,
please let us know of any omissions or errors



Table of Contents

D)1= 0 1= 3
What iS TSM SEUAIO ....uuiiiiiri i e e r s 4
TSM Studio SCreen LayoUL.......civieeiiiriii i r e r e s era e e enaas 5
(o Q= o I = T 6
USEE ProfileS ...eeeei it et r e een 8
LY (o [ o = T IS T = PP 11
(@<= T T 0T L 15
D= 122 N [ 17

L= PP 19

(0] (1] 191 0 =3P 21

G0 TH ] o > I 23

SHOW SUMMAIIES ....iiiiiiiie et rrri s r s e s e e ran e s s seran s s e e rrnnnes 24
TSM Server Menu TEeMS .....iiuiiiiiii e e e e e an e ees 25
07 | o L 30
TSM ComMaNd HelP ... iiieiiiiie et sera s e e s e e aa e ees 32
LIS e 4122 T= [T L PP 33
o= 1] T PP PPPRRPI 34

Trouble Shooting ProblemS........ciiui i e 35



Disclaimer

Direct, incidental, consequential, indirect, or punitive damages arising out of your access to, or use of, the site
and articles within. Without limiting the foregoing, everything on the site is provided to you 'AS IS' WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON
INFRINGEMENT.

"Please note that some jurisdictions may not allow the exclusion of implied warranties, so some of the above
exclusions may not apply to you. Check your local laws for any restrictions or limitations regarding the exclusion
of implied warranties."



What is TSM Studio

TSM Studio is a tool for managing your TSM Studio Environment, it provides
access to a lot of data not available from the ISC and includes a reporting engine for
designing your own reports without the need for a large hardware investment.

TSM Studio runs on your desktop and connects to any TSM Server in your
environment and can provide a consolidated view of all your TSM Servers
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TSM Studio Screen Layout
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TSM Navigation Panel
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The TSM Studio interface has three main sections, The Main Menu and Toolbar, The
Navigation Panel and the Dataview Window.




Look and Feel

The Look and Feel defines the way that TSM Studio looks, each different
Look and Feel provides different colours and “skins” to TSM Studio.

For example “The Asphalt World” Look and Feel gives TSM Studio the
following appearance

pires on Friday, 30 April 2010
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TSM Servers Admin Schedules I

Server Name Description | Command Priority | Startdate Starttime | Duration | Durunits | |

oftware Server 1 | RECLAMA BAGKUP DB 5
|| spirit Saftware Server 1 q mount 5 220062009 1200 AM 065900
S Spiit Software Server £ - (Windews 5.4.0.9) || spirit Software Server 1 backup stg vipool viicopypool 5 201272008 1200 AN 00-00-00
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5
5

1110142010 12:00 AM
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=42 Associations
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While the “Glass Oceans” Look and Feel gives TSM Studio the following appearance

G:¥ Spirit Software TSM Studio - v2.1.0.3 Professional Expires on Friday, 30 April 2010
File View Commands Settings Tools Window Help
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[] spirit Software Server 1 :RECLAMATION BACKUP DB 5 1

Spirit Software Server 1 @ mount 3 1
3% Spirit Software Server 1 - (Windows 5.4.0.0) | spirt sotware server 1 TESTI backup stg vtipool vticopypool 5 20122008 1200 AN 00:00:00 3 HOURS
B Automation [l spirit Software Server 1 TEST3 backup stg vipool viicopypool 5 20122008 1200 AM  00:00:00 5 HOURS
Il spirit Software Server 1 TESTA backup stg vtipool vticopypool 3 Z0MZ2008 1200 AN 00:00:00 5 HOURS
I Admin Schedules Time of Day Diagram D Spirit Software Server 1 TESTY SELECT * FROM NODES 5 500172010 12:00 AM 211724 1 HOURS

&3 Admin Tasks
&3 Admin Tasks Time Line Last 24 Hours
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¥ Client Schedules Time of Day Diagram
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The Look and Feel can be changed in two places, firstly directly from the toolbar

=

File View Commands Settings Tools Window Help
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TSM Servers

—— |1 1H

F Admin Schedules @|

B'_;d Groups
-_,;'.. Spirit Software servers
| ()% TEST

E}ﬁ Servers

E}ﬁi Spirit Software Server 1 - (Windows 5.4.0.0)
E}ﬁ Automation
: Admin Schedules
: §% Admin Schedules Time of Day Diagram

Server Name Schedule Name Description

Spirit Software Server 1

Spirit Software Server 1 TEST
Spirit Software Server 1 TEST1
Spirit Software Server 1 TEST3
Spirit Software Server 1 TEST4
Spirit Software Server 1 TESTY

by simply choosing the new “Look and Feel” required

or from the Options Dialog which can be found under Settings—>Options

‘Settings | Toocls Window Help
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And selecting the Look and Feel Tab

Settings

E,n]erts ”& Debug ” [1sl, TSM Studio Server Charts

General ”i Console ” L& Cache ” =57 Commands ] Look and Feel Praoxy ” % Experimental Support ” E ChargeBack ]

Enable Skins
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User Profiles

Users Profiles is an optional feature that can make the management of your
TSM Userids that are used to connect to TSM Servers in TSM Studio easier.

If you have a number of TSM Servers where the userid and password are the
same or your environment users a central configuration server then it is highly
recommended you use a user profiles, this will mean that when your password

expires or you need to change your password it can be done in one place and not in
each TSM Servers connection settings.

Firstly select the “User Profiles” from with Settings—>User Profiles

Settings | Tools Window Help

Azsaciate User Profile to TSM Servers

Y]

B

Category Manager
Client Opticn Mames

F

2 Health Check Parameters

£ Locations
% Options

g Liser Profiles

Or from the Toolbar

Eﬁ Spirit Software TSM Studio - v2.1.0.3 Professional Expires on Friday, 30 April 2010
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The following dialog is displayed

User Profiles

B+aXiw

Profile Mame | Description

TSM Admin User TSM Admin User 1

EEpirit Software Admin defautl admin user

The Toolbar has the following Options
m Close — Close the Dialog

4; Add — Add a User Profile

4. Edit — Edit a User Profile

x Delete — Delete a User Profile

i Change Password — Change the Password for a Profile

Press the Add a User Profile Button

Usar Profile = 1= e
Profile Mame |Pruﬁle 1 |
Description |Descri|:|ﬁur1 |
|serid |user1 |
Password | e |
Verify | sessesens s |
[U Ok ] [3 Cancel ] i Help




Profile Name: Any description name for the user profile
Description: optional description for this profile

Userid: The TSM Admin Userid

Password: The Password for the Userid

Verify: Re-enter the password for the Userid

Auto-Logon: If Auto-Logon is not checked, then a prompt will be displayed asking
for the logon details
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Adding a TSM Server

There a three ways to add a TSM Server to TSM Studio.

1. From the Main Menu File>Add Server

"’ j
2. ' From the Toolbar

3. From the TSM Server Navigation Window Context Menu

| TsMServers v
o TSM Server Groups
| & Font

= Collapse All £4
B* Expand All

Open Mew Window

if Day Diagram | "m_

Edit Server

Delete Server

Delete Multiple Servers
Dashboard

DRM Properties

COpen Console

Query the Activity Log
Server Properties
Shutdown Server

Storage Pocol Control Panel
Submit Command

Update Version Details
Clear Server Connection Error

Show Server Connection Error

a. [k,  Tools

After selecting the Add TSM Server Option the following dialog is presented

TSM Server Administration

E:

-8
| #) Details " A% Logon ” 17 Locations l
Server Mame |T5I'~"I Server 1 |
Description |
Server Address |seruer1.spiritsuﬁware.biz| |
Part | 1500 (]
[@ Ok |l ’E} Cancel ] ’ ﬁ Test Connection Help




Server Name: Any descriptive name for this new TSM Server Definitions
Description: Optional Description for this TSM Server
Server Address: IP Address of DNS name of the Server

Port: The Port on the TSM Server Listening for Admin requests ( usually

->Select the Logon Tab

TSM Server Administration

(:> Locations

1500)

IUse User Profile

|T‘SM Admin User

| [ﬁ Liser Profiles

|Userid | |

Password | |

Verify | |

L@' Ok ,Hﬂ} Cancel ”ﬁ Test Connection ]

@
]

Either select a User Profile defined previously or

(:) Locations

= ]E]E]

[] use user Profile

[7SM Admin User |

Auto Connect

Userid |Ellelif'l |
Password | - |
Veerify |ttttt |
[I@' Ok ,][ﬂ} Cancel ] [ ! Test Connection ]




The Locations Tab is used when Locations are enabled. Locations are
discussed in details later in this document.

Once Defined the connection can be verified using the Test Connection button

SF SETVED LOTINECTIoT

" Admin CLI Connection Tested Successfully

Once the TSM Server has been created, it will appear in the TSM Server Navigation
window with all the available Dataview Categories and Dataviews. Simply double
click on a Dataview to open it.

-

T

File View Commands Settings Tools Window Help

[ - [ - IS YW .
j ﬁ: 2 e ['#I;I- :1,‘?1. ‘ \(C Look and Feel | The Asphalt World “ ﬁ ? Location: | Spirit Software Solutions |
TSM Servers E‘
-qf'.n Groups Z
BJT Servers
[—:}]T Spirit Software Server 1 - (Windows 5.4.0.0) '*— M TSM Server
[—jﬁ Automation
- Admin Schedules

Dataview Category
1% Admin Schedules Time of Day Diagram

{23 Admin Tasks

-T§ Admin Tasks ﬂr;;nel_astm_
=5 Assodiations N —— Dataview
- Client Schedules

-1 Client Schedules Time of Day Diaaram
{7} Mode Backup Time Line Last 24 Hours
-{T§ Mode Backup Times

[:Hig Catalog

% Charge Back

[, Configuration

rj Database

@ Disaster Recovery

From time to time there will be issuing connecting to the TSM Server ( Server
may down, the userid is locked etc ). When a connection problem occurs TSM Studio

will place a red exclamation mark next to the server and in the Toolbar to indicate
there is an issue
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File View Commands Settings Tools Window Help

[ | - P 2»
¥ | ﬁrj S o pg gb el | Lookand Feel The Asphalt Word
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| | |

B12x°28 Y% #H

B st aoB e ATgQ

T5M Servers E]

—

T Admin Schedules @I

-_.Z'.l Groups

E}P@ Servers
P@ Spirit Software Server 1 - (Windows 5.4.0.0)
P@ Spirit Software Server 2 - (Windows 5.5.2.0)
P@ Spirit Software Server 3 - (Windows 6,1.2.0)
P@ Spirit Software Server 4 - (Windows 5.5.4.0)
f@ Spirit Software Server 5 - (Windows 6.1.2.0)
f@ Spirit Software Server 6 - (Windows 6.1.3.0)
(¥ spirit Software2 Expired
(-9 Spirit Software2 Locked

Server Name Schedule Name

. e e R
Spirit Software Server 1 TEST
Spirit Software Server 1 TEST1
Spirit Software Server 1 TEST3
Spirit Software Server 1 TEST4
Spirit Software Server 1 TESTY

39 Test3 il
&Y

¥ Tests
? Test3
H TESTSS

ription

Command

P DB
q mount
backup stg vtlpool vilcopypoo
backup stg vtlpool vilcopypoo
backup stg vilpool vilcopypoo
SELECT * FROM NODES

To see what the issue is, either click the Red Exclamation Icon in the toolbar or right
click on the TSM Server and select TSM Servers—>Show Connection Errors

- | T5M Servers k| B Add Server

T5M Server Groups  »

-:-l Edit Server
A Font

-

!'."

X »

Delete Server

LA

Collapse All Delete Multiple Servers

Expand All Dashboard

Open Mew Window DRM Properties

Open Conscole
Query the Activity Log
Server Properties

Shutdown Server

Submit Command

Update Version Details

TP T OFE WE S

Storage Pool Control Panel

Clear Server Connection Error

[z, Tools

g Show Server Connection Error ;

]

Once the Error has been resolved choose the Clear Server Connection Error to allow

TSM Studio to connect to the TSM Server

—



Creating Groups

TSM Studio allows the data from multiple TSM Servers to be viewed in a single
display window. For example you may wish to view all the Admin Schedules for all
the TSM Servers in your environment in a single view, this is accomplished by

creating a group containing all the TSM Servers and opening the Admin Schedules
Dataview from the Group.

To create a New Group choose there are three ways to do this

1. From the Main Menu File=>Add Group

-y

2. %* From the Toolbar
3. From the TSM Server Navigation Window Context Menu

T5M Servers 3
|_,f'_| TSM Server Groups  » | | % Add Group M |
A  Font Edit Group "
wmd Collapse All Delete Group
B Expand All Add Server to Group
Open Mew Window Remuowve Server from Group
hedules Change Account Details
Open Console

Query the Activity Log

Submit Command

a.

Once selected the TSM Server Group dialog will be displayed

J [y General Details |'-_ TSM Servers ” Locations |
Marme Mew Group
Description Description

w Ok M cancel @ Help
| |



Name: Enter a Descriptive Name for this Group
Description: Optional description for the group

Select the TSM Server Tab

| [€4 General Details | 5 TsM servers |f~ ' Locations

Spirit Software Server 1
Spirit Software Server 2
Spirit Software Server 3
Spirit Software Server 4
Spirit Software Server 5
Spirit Software Server 6
Spirit Software 2 Expired
Spirit Software2 Locked
Test 3

Test3

TESTSE

Iv Ok J Ix Cancel I |@ Select All | I@ Unselect All I

And choose the TSM Servers that will belong to this group
The Locations Tab will be discussed later in the locations section of this document
A Group will now be created in the TSM Server Navigation window and looks the

same as the TSM Server layout, except for the addition of a members category.

-

iZr

File View Commands Settings Tools Window Help

= = =
‘j Tr i E - l‘-*l;l- g& "‘{l‘\ Look and Feel | The Asphalt World “
TSM Servers EI

I_T_}-_,:'..u Groups

Y i Soitvere servers ]
[—]'?% Automation

i Admin Schedules

~43 Admin Tasks

~4:5 Admin Tasks Time Line Last 24 Hours
a‘g Assocations

- Client Schedules

-4§ Mode Backup Time Line Last 24 Hours
~4§ Mode Backup Times

E—]@ Charge Back

5:1, Configuration

ﬁ Database

@ Disaster Recovery

i_".Q Libraries and Volumes

-_ Members

Monitor

+HEP Polides
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Dataviews

After creating a TSM Server or TSM Server Group a structure of Dataview
Categories and Dataviews is created. These Dataviews provide access to TSM
Objects or Data, the majority of the Dataviews return data in a grid type layout
similar to the following

[ Admin Schedules [x]

Schedule Name Description Priority Startdate Duration
3 E 1

Spirit Software Server 2 TEST q mount 5 Z2106/2009 12:00 AM 07:25:00 1 HOU
Spirit Software Server 2 TEST2 BACKUP DB 3 131172009 12:00 AN 06:10:00 1 HOU
Spirit Software Server 2 TEST3 backup db 5 110472010 12:00 AM 08:36:00 1 HOU
Spirit Software Server 1 RECLAMATION BACKUP DB 3 12010 12:00 AN 221428 1 HOU
Spirit Software Server 1 TEST q mount 5 Z2106/2009 12:00 AM 06:59:00 1 HOU
Spirit Software Server 1 TEST1 backup stg vtipool vilcopypool 5 2001272008 12:00 AM 00:00:00 5 HOU
Spirit Software Server 1 TEST3 backup stg vilpool vilcopypool 5 201272008 12:00 AN 00:00:00 5 HOU
Spirit Software Server 1 TEST4 backup stg vilpool vilcopypool 5 2011272008 12:00 AM 00:00:00 5 HOU
Spirit Software Server 1 TESTY SELECT * FROM NODES 3 H2010 12:00 AM 24724 1 HOU
Spirit Software Server 3 TEST1 backup stg vtlpool vilcopypool 5 2001122008 12:00 AM 11:39:00 5 HOU
Spirit Software Server 4 RECLAMATION BACKUP DB 3 1104/2010 12:00 AN 221428 1 HOU
Spirit Software Server 4 TEST q mount 3 ZE06/2009 12:00 AN 06:39:00 1 HOU
Spirit Software Server 4 TEST1 backup stg vilpool vilcopypool 5 201272008 12:00 AN 00:00:00 5 HOU
Spirit Software Server 4 TEST3 backup stg vtlpool vilcopypool 3 2022008 12:00 AM 00:00:00 3 HOU
Spirit Software Server 4 TEST4 backup stg vtlpool vilcopypool 3 20122008 12:00 AN 00:00:00 3 HOW
Spirit Software Server 4 TESTY SELECT * FROM NODES 3 S02000 12:00 AM 2001724 1 HOU
Spirit Software Server & RECLAMATION BACKUP DB 3 1104/2010 12:00 AN 221428 1 HOU
Spirit Software Server § TEST q mount 5 ZH06/2009 12:00 AM 06:59:00 1 HOU
Spirit Software Server & TEST1 backup stg vtlpool vilcopypool 3 2011272008 12:00 AM 00:00:00 3 HOW
Spirit Software Server & TEST3 backup stg vtlpool vilcopypool 3 2022008 12:00 AM 00:00:00 3 HOU
Spirit Software Server & TEST4 backup stg vtipool vilcopypool 5 20122008 12:00 AN 00:00:00 5 HOW |
Spirit Software Server & TESTY SELECT * FROM NODES 3 S02000 12:00 AM 2001724 1 HOU
Spirit Software Server 3 RECLAMATION BACKUP DB 5 110472010 12:00 AM 22:14:28 1 HOU
Spirit Software Server 3 TEST q mount 5 ZH06/2009 12:00 AM 06:59:00 1 HOUE—

| B

When open a Dataview from an individual TSM Server the data for that

selected server will be displayed. When opening a Dataview from a TSM Server
Group, the data from all the TSM Servers in the group will be displayed.

The rest of this section of Dataviews covers Dataviews that are displayed in a
grid layout, all of these types of Dataviews have a common menu structure which
will be discussed here. A few of the Dataviews are charts, diagrams or graphs each
has its own menu structure which is not discussed in this document.

17



The Common Menu Items for all Dataviews are as follows

==/ Print — Print the Dataview, The print dialog also has a number of options
for exporting the Dataview to other formats

=

Copy — Copy the Selected Rows to the Clipboard
% Refresh — Refresh the contents of the Dataview

@é Timer — Used to Automatically refresh the contents of the Dataview

-

] TSM Servers — Can be used to add or remove TSM Servers from this
particular Dataview

3 Show Command — Shows the Commend being executed
A Fonts — Change the Font being used in the Dataview

= Last Run Results — Show the Results from the last collection of Data for
this Dataview from the TSM Servers

@ Export — The Dataview can be exported to CSV, PDF and other formats

=Rv Alternate Row Colour — used to change the colour of every 2™ row to
make viewing the data easier

* 9

= Columns — Used to change the location, visibility and format of the
columns ( Explained in more detail later in this section )

= Enable and Disable Line Numbers

=
1 Enable Group By ( Explained in more detail later in this section )

ke Select All ( Select all the Rows in this Dataview)

18



=]
“& Show Summaries — Used to Provide Column averages and Totals (

Explained in more detail later in this section )

H Reporting, Report Designer and Reports will be discussed in an upcoming
Document

Migrate:  Also on selected Dataviews you will notice a Migrate Menu
Option, this is used to migrate the objects in this Dataview from one TSM Server to
another, just select the items to Migrate, select the Migrate option and choose the
server to Migrate the object(s) to.

Commands: Most of the Dataviews also have a commands menu item,
under this menu item are TSM Commands that can be executed on the selected
items.

For example in the Admin Schedules Dataview there are commands to Add,
Edit, Delete, Enabled and Disable Schedules

- In the Volumes Dataview there are options to make a volume(s) readonly,
readwrite, discard etc.

Filters

Also available in a Dataview is the ability to Filter the data in the displayed
columns. Simply move the mouse into the column to be filtered and a small filter
button will appear

[ Admin Schedules |Z||

Server Name | Schedule Mame Description Command | Priority ‘ Startdate

Spirit Software Server 2 TEST2 BACKUP DB 5 13172009 12:00 AN
Snirit Snftware Server 7 TFST3 hackun dh 5 1100 12-00 AM

Spirit Server 2 EXPIRATION Inventory Expiration Expire Inventory 3 Z2N2000 12:00 AM
pirit Software Server 2 TEST q mount 5 2062009 12:00 AM

19



Click the Button to display the filter dialog

J B Admin Schedules IEI|

Server Name

Spirit Software Server
Spirit Software Server
Spirit Software Server
Spirit Software Server
Spirit Software Server

Spirit Software Senr-erl (Blanks)

(Custom)

(Man blanks)

Spirit Software Server 1
Spirit Software Server 2
Spirit Software Server 3
Spirit Software Server 4
Spirit Software Server 5

1 .. Spirit Software Server &
Spirit Software Server

Either choose the value to filter on or build a custom filter apply to the data.

After Applying the filter a Edit Filter button will be displayed to allow further
customization of the filter

[ Admin Schedules [x]

T

. . [Server Name] = "Spirit Software Server 1

Server Name | Schedule Name | Description Command | Priority | Startdate | Starttime | Duration | Durunits

Spirit Software Server 1 RECLAMATION BACKUP DB 3 TI72010 12:00 AM 221428 1 HOURS
N Spirit Software Server 1 TEST q mount 5 Z206/2009 12:00 AM 06:59:00 1 HOURS
] Spirit Software Server 1 TEST1 backup stg vtipool vilcopypool 5 20122008 12:00 AN 00:00:00 5 HOURS
T I P T T M Y

Spirit Software Server 1 TEST4 backup stg vilpool vilcopypool 5 201272008 12:00 AN 00:00: 5 HOURS
| Spirit Software Server 1 TESTY SELECT * FROM NODES 3 H2010 12:00 AM 24724 1 HOURS

dlt FI|tEI

(<]

>

It is also possible to save the filter for future use, from the Dataview Context Menu

or Toolbar select the Save Filter button W

20



Filter Mame MewFilter

|U Ok ||§C Cancel |

Enter the Name of the Filter to Save

To Reuse the Filter, select the Load Filter Button from the Context Menu or Toolbar
<7

Filter MewFilter

|v Ok ||§C Cancel |

And Select the Filter to be loaded

Columns

Columns in a Dataview can be hidden, have their titles change or have they
can be moved to new locations.

Choose the =3 Columns option from the Dataview context menu or Toolbar
and the following dialog will be displayed.

21



Select Columns
B dxdv=0Q ¥
Column Mame | Column Display Text | Hidden | Alignment Format Type z

b [Server Name Server Name |:| String
| [screDULE NaME schedule Name O String
] DESCRIPTION Description D String
| |commann Command O String
| |prIoRITY Priority | Right MO Int64
] STARTDATE Startdate | Right a DateTime 3
| |srarTTvE Starttime O Right g TimeSpan 1
|| DURATION Duration D Right MO Int64
| |ourunTs Durunits O String
| |peRIOD Period | Right MO Ints4
| |pERUNITS Perunits J String
|| oavorwesk Dayofwesk O String
|| EXPIRATION Expiration |:| Right q DateTime |
| |acTve Active J String
| ] CHG_TIME Chg Time O Right a DateTime
| |cHe_apmm Chg Admin | String
| |proFiE Frofile O String Z

Use the Up and Down arrows to move the rows to a new location, or type a new
Title in the Column Display Text or click the Hidden Column to show\hide the
column.

Also Columns can be moved simply by dragging the titles to the new location

N
N



Group By

The Group By function allows you group the data in a Dataview by a particular

columns of multiple columns. To enable this feature choose E Group By from the

Context Menu or Toolbar

J AT Admin Schedules E]l

Drag a column header here to group by that column

[} Spirit Software Server 1
Epirit Software

Server 1 TESTY

T R T

SELECT * FROM NODES

3 B0 1200 AM

2H:AT:24

Server Name | Schedule Name | CoMgand | Priority | startdate | Starttime | Duration | Dun
Spirit Software Server 1 RECLAMATION BACKUP 3 10972010 12:00 AM Fra bl 1 HOu
] Spirit Software Server 1 TEST g mount 5 22/06/2009 12:00 AM 06:59:00 1 HOU
] Splrlt Saoftware Server 1 TEST1 backup stg vtlpool 3 2011272008 12:00 AM 00:00:00 3 HOU
Epirit Software Server 1 TEST3 backup stg vilpool vilcopypagl 5 22008 12:00 AM 00:00:00 5 HOU

o e w3l

1 HOU

And a new panel will be drawn above the Dataview. To Group your data simply drag

a column into this new area

J F Admin Schedules E]l

Schedule Name =

Deacription

Server Name:
Server Name:
Server Name:

Server Name:

k H E':BI"‘J&I’ Mame Splrlt S.n.f'.h\are E‘uerver l
[#] Schedule Name: REGLAMATION
Schedule Name: TEST
Schedule Name: TEST]
Schedule Name: TEST3
Schedule Name: TEST4
Schedule Name: TESTY

Server Name:

Spirit Software Server 2
Spirit Software Server 3
Spirit Software Server 4
Spirit Software Server 5
Spirit Software Server &

Priority Startdate i

Duration

Durunits i i

N
w



Show Summaries

Summaries Allow the totalling, averaging, counting, Max and Min of any

el
column in the Dataview. Simply select the <& Show Summaries button from the
Context Menu or Toolbar and the following dialog will appear.

Choose the Column and the Summary Type

Column

Stogpool Mame

Enable Summaries E %

Summary Type [Count

(@ ok

[ cancel |

And the value will be displayed at the bottom of the selected column

[ Storage Pools [

Server Name | Stgpool Name | Poaltype | Develass | Eat Capacity Mb | Trigger Pct Util | Pet Utilized | Pet Migr | Pet Logical Highm

Spirit Software Server 2 BACKUPPOOL PRIMARY DISK 0.00 000 000 0.00 100.00
|| Spirit Software Server 2 DISKPOOL PRIMARY DISK 0,004.00 0.00 0.00 0.00 i00.00
|| Spirit Software Server 2 SPACEMGPOOL  PRIMARY DISK 0.00 0.00 0.00 0.00 i00.00
|| Spirit Software Server 2 TESTACTIVE ACTIVEDATA VILDLT 0.00 0.00 0.00
] Spirit Software Server 2 TESTDISKPOOL  PRIMARY DISK 0.00 000 000 0.00 100.00
] Spirit Software Server 2 VILGOPYPOOL  COPY VILDLT 0.00 000 000
|| Spirit Software Server 2 VILPOOL PRIMARY  VTLODLT 699,930,000.00 0.00 0.00 .80
|| Spirit Software Server 4 ARCHIVEPOOL  PRIMARY DISK 0.00 0.00 0.00 0.00 i00.00
|| Spirit Software Server 4 BACKUPPOOL  PRIMARY DISK 0.00 0.00 0.00 0.00 100.00
] Spirit Software Server 4 DISKPOOL PRIMARY DISK 4.00 000 000 0.00 100.00
] Spirit Software Server 4 SPACEMGPOOL PRIMARY DISK 0.00 000 000 0.00 100.00
] Spirit Software Server 3 ARCHIVEPOOL  PRIMARY DISK 0.00 L] L] 0.00 100.00
|| Spirit Software Server 3 BACKUPPOOL  PRIMARY DISK 0.00 0.00 0.00 0.00 i00.00
|| Spirit Software Server 3 DISKPOOL PRIMARY DISK 1,000.00 0.00 0.00 0.00 100.00
|| Spirit Software Server 3 SPACEMGPOOL  PRIMARY DISK 0.00 00 0.00 0.00 100.00
] Spirit Software Server 3 VILPOOL PRIMARY DEVCLSLTO 2,104,309, 54800 000 0.00 99.50
] Spirit Software Server 3 ARCHIVEPOOL  PRIMARY DISK 000 000 0.00 100.00
|| Spirit Software Server 3 BACKUPPOOL  PRIMARY DISK 0.00 0.00 0.00 i00.00
|| Spirit Software Server 3 DISKPOOL PRIMARY DISK 50,000.00 0.00 0.00 0.00 i00.00
|| Spirit Software Server 3 SPACEMGPOOL  PRIMARY DISK 0.00 0.00 0.00 0.00 100.00
] Spirit Software Server 6 ARCHIVEPOOL  PRIMARY DISK 0.00 000 000 0.00 100.00
] Spirit Software Server & BACKUPPOOL PRIMARY 0.00 000 000 0.00 100.00
|| Spirit Software Server & DISKPOOL PRIMA DISK 50,000.00 0.00 0.00 0.00 i00.00
|| Spirit Software Server 6 SPACEMGPOOL P DISK 0.00 0.00 0.00 0.00 i00.00

sl

£ ” m
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TSM Server Menu Items

In the Context Menu for a TSM Server

TSM Servers

™
[*}-o== Groups

There are a number of options available to make administration of a TSM Server

easier.

|7 storage Pools 3] |

Add Server: Add a New TSM Server to TSM Studio

Edit Server: Edit a TSM Server Definition

Delete Server: Delete the Selected TSM Server from TSM Studio

- | Server Name | Stgpool Name Poo
E}P[ Servers _ Spirit Software Server 2 BACKUPPOOL  PRIN
PE Spirit Software Server 1 - (Windows 5.4.0.
H PRIN
PE Spirit Software Server 2- (W[ £ | TSM Servers 3 | |'E Add Server
L B . . = = PRIN
fl: Spirit Software Server 3 - (W _.'_"_u TSM Server Groups  » | 4 Edit Server
fl: Spirit Software Server 4 - {0 ACTI
J'E Spirit Software Server 5 - (i A Font K Delete Server PRIN
PE Spirit Software Server & - (W wa  Collapse All £ Delete Multiple Servers COP
i' Spirit Software 2 Expired -
: " Expand All 4  Dashboard PRIN
i' Spirit Software 2 Lodked g P o
? Test 3 Open New Window @ DRM Properties PRI
: PRI
? Testb Bl Open Console
(¥ Tests — y PRIK
! : uery the Activity Lo
e TESTES Query tytog PRIN
B Server Properties BRI
[@ Shutdown Server PRI
[i1! Storage Pool Control Panel PRIN
% Submit Command FRIN
%  Update Version Details PRIK
. PRI
? Clear Server Connection Error
PRIN
¥ Show Server Connection Error
® PRI
[, | Tools PRI
| I P - ) S ———— _—

Delete Multiple Servers: Allows the deletion of Multiple TSM Servers from TSM Studio

Dashboard: Starts the TSM Studio Server Dashboard
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DRM Properties: Open the following DRM Properties Dialog where DRM Settings can

be modified

DRM Properties - Spirit Software Server, 1 3]

|55pirit Software Server 1

TSM Server

Flan Prefix

Courier Mame

Vault Name

Recovery Instructions Prefix
Yolume Append Character

Mot Mountable Location Mame

E

@

INGTMOUNTABLE

\COURIER

\VAULT

Command File Mame |

Database Backup Expiry (Days) |

60 2]

Recovery Flan File Expiry (Days) |

B

Chedk Tape Labels when using MOVE DRMEDIA commands

[ ] Process Vaolumes using File device class

[ﬁ Ok ”'EB' Cancel ”:'E Preview Command l

Open Console: Open the Console view to this TSM Server

|§| Console - Spirit Software Server 1 [Z]l

Server

| Messape Time

|Mess.agmeH.unijer |Mess.age

Spirit Software Server 1

Spirit Software Server 1
| Spirit Software Server 1
Spirit Software Server 1
Spirit Software Server 1
Spirit Software Server 1
Spirit Software Server 1

Spirit Software Server 1

pirit Software Server 1

4/04/2010 3:33:41 PM
4/04/2010 3:33:41 PM
40472010 3:33:41 PM
4/04/2010 3:33:50 PM
4/04/2010 3:33:50 PM
4/04/2010 3:33:50 PM
4/04/2010 3:33:50 PM
40472010 3:33:54 PM

ANRO4OTI
AMR201 71

IBM Tivoli Storage Manager
Command Line Administrative Interface - Version 6, Release 1, Level 0.0
(c) Copyright by I1BM Corpeoration and other(s) 1990, 2009. Al Rights Reserved.
Session established with server SPIRITSOFTWARET: Windows
Server Version 5, Release 4, Level 0.0
Server date/time: 04/04/2010 15:32:01 Last access: 04/04/2010 15:20:59

Session 12 started for administrator ADMIN (WinNT) (Tcp/lp 192-168-1-3.tpgi.com

Administrator ADMIN issued command: QUERY PROCESS

4/04/2010

Spirit Software Server 1 4/04/2010 3:33:54 PM ANRZO17I

ANRZOMTI

Administrator ADMIN issued command: ROLLEBACK

Administrator ADMIN issued command: QUERY SESSION

(<]l

N
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Query the Activity Log: Open the Query Activity Log Dialog

@ Basic [W]

Begin Date | =
Begin Time 12:00:00 AM &l

End Date | v
End Time 112:00:00 AM B
Search String |

@ o (s oo

Server Properties: Open the Server Properties Dialog where a large number of TSM
Settings can be changed

Sarver Properties - Spirit Software Server 1 @

TSM Server |Spirit Software Server 1 |

J ﬁ Server Details " ¥ Logging ” t Security ” lﬂl Info ” f Scheduling ” SOL SOL l

Server Mame |5PIRII’SDFI’WARE 1 |
IP Address 152.168.2.105 |
Port | 1500 (£

Server URL | |
Sub File Backups ~ |NO =

Log Mode INORMAL ™

Registration Type | CLOSED ™

Refresh from Config Manager Interval ( mins ) | 50 @l

TOC Load Retention (mins) | 120 |

[ ] configuration Manager

[ ] Cross Define

[ ] Activate Data Retention Protection

L@ Ok ,HEB Cancel ”E Preview Command i Help

N
N



Shutdown Server: Issues the Halt command to the TSM Server

Storage Pool Control Panel: Starts the Graphic Storage Pool Control Panel

Storage Pool Control Panel

TSM Server |Spir1't Software Server 1 |E||
Storage Pool | DISKPOOL v
Description |
Migration Reclamation Access Collocation
High Low Processes Threshold Processes () Read Only Mo
94 74 1 0 0 e
= = N - (*) Read Write
z o B - Hode
E = ) - () Unavailable Filespace
- = 3 ) Shred Passes - 0
Sl E : : _ =
z - o - I i
= [] CrC Data
Dctay, | > @| : . [] cache
Continue - -
Mext Storage Pool Reclaim Storage Pool
|(N°”E} | | (Mone) |E||
Scratch Deduplication
Max Scratch || Enable Ellentif‘.r Processes - 0
|V_teoy |[F3 cose |[  prevew |

Submit Command: Allows command to be submitted to the TSM Server

Submit Command

Command ||

| ok |[3€ cancel |[E] Previous Commands | [€) TSM Command Help

N
0e}



Update Version Details: Tells TSM Studio to check the version of the TSM Server and
update the TSM Server Navigation Window

E}T Servers
e} e Spirit Software Server 1 - (Windows 5.4.0.0)

T Spirit Software Server 2 - (Windows 5.5.2.0)
T Spirit Software Server 3 - (Windows 6. 1. 2.0)

Tools>Putty Session: Start a putty session to the selected TSM Server

Tools>Remote Desktop Session: Start a Remote Desktop Session (RDP) to the
selected TSM Server

Tools=>TSM Admin CLI Session: Start a TSM Admin CLI session to the selected
Server

Tools>TSM Admin CLI Console: Start a TSM Admin Console session to the selected
Server
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Locations

The Locations feature available only in the Professional version was primarily
designed for those contractors that move from site to site, and would only to see the
TSM Servers for the location they are working on.

Once Locations are enabled some new icons will appear in the toolbar

Eﬁ Spirit Software TSM Studio - v2.1.0.3 Professional Expires on Friday, 30 April 2010

File View Commands Settings Tools Window Help

=)
.j | ﬁd E | -;_‘I D@: %h lx\‘ | Look and Feel | The Asphalt world | @ ﬁ | Q | ‘; Location: | Spirit Software Solutions Lab
TSM Servers @
B'.:d Groups

k¥ Spirit Software Servers
: Automation

Charge Back

' Configuration
Natzhase

Only the TSM Servers and TSM Server Groups in the selected location will be visible
from with TSM Studio. When the default location “Default” is selected then all TSM
Servers and TSM Server Groups will be available.

To Enable Locations go to Settings->Options and select the General Tab

Settings E %
z:_., Alerts || 8% Debug ” MTSM Studio Server Charts
[l General liConsoIe || . Cache || 5 Commands | Look and Feel || [ Proxy || %Experimemﬁl Support || 1‘?9 ChargeBack |
Working Directory c:\temp B
DSMADMC.EXE Location C:\Program Files\Tivoli\TSMbacdlient\dsmadmc. exe E]
Putty Path C:VProgram Files (x86)\PuTTY \putty.exe B
Remote Desktop Path E]
ble Locations (Only Available in the Professional Version)

g@ .......... i ,l [8 p— I

Check the Enable Locations Checkbox

w



To Add and Modify Locations select the Locations Icon from the Toolbar and
the following dialog will be displayed

Site 1 Alternate Site
Spirit Software Solutions Lab R&D Lab

Click the add button to add a new Location. Enter a location nhame and description
and choose the TSM Servers and TSM Server Groups that will be available in this
location

Add Location |:| m| %

Location |Nechc |

Description |Descrui|:lt |

_,Z'.nGraups ﬁ Servers

[ ] ANl Servers

[] spirit Software Servers
[ ] sydney Servers

Test

Vo ][ cane

—



TSM Command Help

TSM Studio provides access to the TSM Help on the TSM Servers in your

environment. Choose the “ Display TSM Command Help from the Toolbar.

The first time you run this TSM Studio will connect the selected TSM Server and
download the available commands, this happens only once.

Reference TSM Server Spirit Software Server 2

Command DELETE DEVCLASS (Delete a device dass)

= =]

Variation DELETE DEVCLASS (Delete a device dass)

&Command % Syntax ” FE Parameters ” A9 Priviege ” =¢ Related Commands

DELETE DEVCLASS (Delete a device class)

I Example || E Full Help

Use this command to delete a device class.

To use thisz command, you must first delete all storage pools assigned to
the specified device class and, if necessary, cancel any database dump,
eXport, or import processes that are using the dewvice class.

You cannot delete the device class DISE, which i=s predefined at
installation, but you can delete any device classes defined by the
Tivoli Storage Manager administrator.

lg Close H.,“ Reload into Cache J

Reference TSM Server: TSM Studio only stores the TSM Commands not the Help
Text for those commands. The Reference Server is the TSM Server that will be used
to get the Help Text from once a TSM Command is selected.
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TSM Commands

Most of the TSM Commands can be executed from TSM Studio Commands Menu,
select the command to be executed, entered the required data for the command and
execute

L:® spirit Software TSM Studio - v2.1.0.3 Professional Expires on Friday, 30 April 2010

File View |Commands | Settings Tools Window Help

3 | v Aecept > 9 " | Lookand Feel |The Asphalt world || ¢ W | ‘!
W' Activate

S Assign 3
[=}ota Groups
Chia 5 Audit 3
% W Backup 3
5? . Checkin »
Eag
Q Q[}- Checkout »
@ & Clean 3
L-I’-'? . Convert  »
= My C 3
°PY
8P & Define 3
Al
"’%‘J |ﬂ Events 3
s |
} E Expire 3 =
- @ Export 3
Tt Extend 3
} & Grant 3
- @ Irmport 3
- lE‘ Label b v By Storage Poaol
1 4 v Mode Totals
. Lock g v Mode Totals by Backup T...
- =0 Migrate  »
) E Reduce  »
} ,é. Register » Jers
B'«( B} Restore  »
= {4
(b TE: £ Revoke 3
E}ﬁ Server .
i i H
GHE sp 03 Sessions b Rione 5.4.0.0)
GHE spi #F Set v Windows 5.5.2.0)
G5 spi W Shred , Windows 6.1.2,0)
R soil indows 5.5.4.0) h
ﬁ TSM Sery| [ Unlock ¥ fvers VL Servers
8F Validate »

w
w



After purchasing a license for TSM Studio a Product Key will be issued to the

Licensing

email address entered during the purchasing process. From TSM Studio go to

Help—>Activate License

C:% Spirit Software TSM Studio - v2.1.0.3 Professional Expires on Friday, 20 April 2010

File View Commands Settings Tools Window [Help

v r.J
gh 00 | Lok ana) $

Ak - AP0

Servers

E}-.-;.n Groups

B-;:.l Spirit Software Servers
'& Automation

m Charge Back

% Configuration

Q Database

G Disaster Recovery
tﬁ Libraries and Volumes
'L_, Members

Manitor

w:' Policies

ﬁ Security

EI,& Storage

-3 Audit Qecupancy
: E BackupSets

@
“
@
b

Contents

4 What's Mew in this Release

Display TSM Command Help
Email Support
Spirit Software Web Site

L 2]
9
L

|

Release License
Check for Updates
About

ﬁ ‘ Q, | u :rl Location: | Spirit Softwar
il

Enter the Product Key and Press Activate

Activate TSM Studio

Product Key

[V Activate ”x Cancel ”EI Copy From Clipboard ”ﬁl Praxy Server ]

Help

If you need to move TSM Studio to a new workstation, simply use the release

license function

L% Spirit Software TSM Studio - v2.1.0.3 Professional Expires on Friday, 30 April 2010

File View Commands Settings Tools

Window |Help|

T | ¥ % | 2a| e gh x| Lookana

Contents

TSM Servers

B-_—.:.l Groups

E-;:u Spirit Software Servers
% Automation

m Charge Badk

% Configuration

8 Database

@ Disaster Recovery
tﬁ Libraries and Volumes
i___ Members

Manitor

w:' Policies

ﬁ Security

He®CEP

What's Mew in this Release
Display T5M Command Help
Email Support

Spirit Software Web Site

Activate License

ﬁ | Q' | L. ;" Locaticn: |Spirit Software
i

ﬂ About

|

%' Check for Updates
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Trouble Shooting Problems

When trying to connect to a TSM Server, the following error is received

ANSO0101E Unable to open English message repository 'dscenu.txt'

This error is a result of the administrative cli
program, “dsmadmc.exe”, unable to find the message file.

To start, you can check if the dscenu.txt file exists in the c:\program
files\tivoli\tsm\baclient directory ( assuming, you installed the TSM client in
the default location ).

If the file exists, try adding the following environment variable

DSM_DIR=C:\Program Files\Tivol\T SM\baclient
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